




MUTABLE
Volume 1: Jazz Age Newspapers

A Note About Copyright and Licensing
The raw materials which make 

up the templates found in Mutable 
Deceptions, Volume 1 – the fonts, text 
from period news stories, and graphics 
from period newspapers – are all free 
from licensing requirements, either 
by virtue of expiration of copyright, 
release into the public domain by their 
creator(s), licensing under a creative  
commons license permitting derivative 
works and commerical exploitation, or 
other similar means. 

The templates themselves (the 
arrangement of components and re-
engineering of period articles from 
raw text) are derivative works which 
are copyright © 2013 by Cthulhu 
Reborn Publications.

In purchasing this product, you have 
purchased a license for unlimited personal 
use  of the templates. You can use the PDF 
form templates to produce any number 
of prop documents; you can create 
alternate “templates” by modifying the 
text contained within the form fields and 
saving these as new PDF files.

You cannot, however, re-distribute 
the unmodified template PDFs (i.e., 
the product as you received it).

When you create props – either 
physical printed props, digital images 
captured from a PDF reader, or saved 
PDF forms – you are free to distribute 
them to  others for personal use, for 
example as part of a pen-and-paper 
roleplaying game. 

This license in no way extends to 

commercial use of the PDF templates. 

If you would like to use the material 

contained in Mutable Deceptions, 

Volume 1 as part of a commercial 

project (e.g., to create props for a film, 

handouts for a commercial publication, 

or for use within a computer game), 

please enquire with Cthulhu Reborn 

regarding a commercial license. 

If you have a special requirement 

for higher-resolution versions of 

these templates, you can similarly get 

in touch with us at Cthulhu Reborn 

to discuss availability of enhanced 

versions of this product.

C R E D I T S
The PDF templates which make up the heart of Mutable 

Deceptions, Volume 1 were assembled and re-typeset from 
numerous historical sources by Dean Engelhardt, who also 
wrote, editied and produced this information booklet.

The PDF templates were tested prior to their release by: 
Badger McInnes and Clint Warlick.

The fonts used in this product are all available on the 
Internet for free download; see the detailed typographical 
notes on page nine for details and font credits.

Support material for Mutable Deceptions, Volume 1, 
including download links for modified versions of text 
body fonts, can be found at cthulhureborn.wordpress.com. 
The Cthulhu Reborn blog also hosts a range of free support 
material for Lovecraftian roleplaying games including free 
scenarios and designer character sheets.
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INTRODUCTION
Period newspaper props and handouts are a much-

treasured staple of most Investigative and Mystery 

roleplaying games, in particular Jazz Age horror 

games like Call of Cthulhu and Trail of Cthulhu. 

Players love the tactile thrill of receiving a well-

crafted newspaper clipping, whether it be the clue 

which kicks off an investigation, the reward for hours 

of hard library research, or a piece of misdirection 

designed to send them off on a wild goose chase.

But making your own realistic-looking period 

newspaper clippings is not necessarily a quick and 

easy task. There are distinctive typographic styles, 

including font choice and layout conventions, which 

distinguish well-crafted period-authentic props from 

those which have been hastily-drafted using modern 

word processing software. And, in keeping with high 

standards of realism set by commercial products, such 

handouts should also incorporate evocative graphics 

in the form of realistic photographs or advertisements 

appearing on the reverse-side of the page. 

So, what’s a Gamemaster/Keeper/Dungeon Master 

to do in situations where he or she wants to create an 

authentic-looking newspaper prop for a new scenario, 

or for a published scenario which lacks good-quality 

handouts? Or maybe knock together a quick newspa-

per report mid-adventure recording the consequences 

of actions taken by the players? Or which leads them 

off on a tangent of their own devising?
Mutable Deceptions, Volume 1 aims to make the 

process of creating realistic-looking newspaper props 

from the 1920s and 1930s quick and easy. It does 

this by providing a selection of article templates, 

each a fillable PDF form. Included in this package 

are fourteen templates of varying shapes and sizes 

which can be effortlessly customised to create an 

endless array of 1920s/1930s-authentic props. Bring 

your own text, or manipulate the bizarre real-world 

stories already pre-filled into the forms.
As a bonus, a sampling of 1920s photos are 

provided for you to use as you like to embellish 

your handouts with just the right type of blurry, 

grainy illustration.
Baffle your players. Have them chasing shadows. 

It doesn’t get any easier than this.

What’s   In   This   Package?

Pre-Filled Content ASTOUNDING NEWS STRANGER THAN FICTION

Apart from this instruction booklet, 
Mutable Deceptions, Volume 1: Jazz Age 
Newspapers is made up of a collection 
of sixteen pages of editable templates 
for newspaper articles of different siz-
es and shapes. All up, there are four-
teen different double-sided article 
templates, each of them rendered in a 
style reminiscent of American news-
papers of the 1920s and 1930s. 

The main element of each arti-
cle template is the central editable 
article itself (consisting of an arti-
cle body and at least one editable 
headline and perhaps other fields as 
well). The main article is surrounded 

by clipped parts of other articles or 
advertisements; these representing 
other parts of the newspaper which 
were typeset around the main article. 
The templates also include a reverse 
side of each of the clippings, contain-
ing further articles or advertisements 
that were typeset onto the other side 
of the page featuring the main arti-
cle. Both the surrounding parts and 
the reverse sides of the templates are 
static and cannot be edited.

Although the use of photographs 
in Jazz Age newspaper articles was 
much less common than we are used 
to, you may wish to use the tem-

plates in this kit to create illustrated 
newspaper articles. Generally, in or-
der to do this you will need to find 
some appropriate images yourself. 
However, in order to provide some 
quick and easy material which may 
be helpful in illustrating the types of 
articles most likely to feature in role-
playing scenarios, Mutable Decep-
tions, Volume 1 includes four bonus 
pages of period-authentic photo-
graphs clipped from real newspa-
pers of the era. Each of the images 
on these bonus pages includes a 
small editable field where you can 
enter a caption for the photograph.

Although the templates in Mutable 
Deceptions, Volume 1 are intended for 
you to fill with your own news sto-
ries, we have pre-populated them with 
some representative articles just so you 
can see how the template looks with 
text in it. This text can easily be deleted 
simply be selecting it and hitting delete.

The news articles which make up 
the pre-filled content – as well as 
the material which makes up the 
“decoration” around the article and 
on its reverse side – all come from 
real-world newspapers. Dozens of 
different American newspapers 
from the era 1920 to 1935 were con-

sulted in order to faithfully recre-
ate these items. No modification 
was made to the stories, advertise-
ments or letters which make up 
this content … which only goes to 
show that even in the real-world, 
bizarre things happen more often 
than you would think.
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HOW TO USE THE TEMPLATES
To use Mutable De-

ceptions, you will need a 
recent version of Adobe 
Reader, available for free 
download from http://get.
adobe.com/reader

The form templates may 
work with other PDF read-
ers, but they have not been 
tested with software other 
than the standard Adobe 
Reader and no guarantees 
are made with respect to 
compatibility with other 
software. Some cut-down 

versions of PDF readers, 
such as non-Adobe prod-
ucts provided for tablets 
and mobile devices, have 
limited or no support for 
fillable PDF forms, and as 
such are unlikely to work 
with Mutable Deceptions. 
At the time of release, the 
official Acrobat Reader for 
iOS and Android does not 
support the editable form 
fields contained in these 
templates (although it will 
happily display a form cor-

rectly once it has been 
filled in using a laptop or 
desktop computer).

Once you have opened 
the Mutable Deceptions, 
Volume 1 Templates PDF in 
Acrobat Reader, you should 
see something approximat-
ing the nearby figure. This 
is the front (article) side of 
the first template. If you 
scroll through the PDF file, 
you will see that this page 
is immediately followed by 
the reverse side of Tem-

plate #1, then Templates 
#2 through #8.

The front sides of each 
of the eight templates are 
fillable PDF Forms. The 
sections shown in blue are 
editable form fields. For 
comprehensive help on us-
ing Acrobat Reader to fill 
in forms, consult the in-
built Help from within the 
reader software. The notes 
below give some specific 
pointers which are specific 
to Mutable Deceptions.
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Anatomy of a Template
The figure below shows the 

different parts which make up each 

of the article templates included 

with Mutable Deceptions, Volume 

1. Note that the “Properties Bar” 

(shown as  in the figure) will 

likely not be visible when you 

first open the PDF – see the notes 

below for “Editing Article Bodies” 

for instructions on how to open 

this dialogue. 

Each article is made up several 

text fields, of which there are two 

distinct types – short fields of 

highly formatted text (headlines 

and the like, marked as  in the 

figure) and larger fields (the body 

of the article, possibly divided into 

several columns, marked as  in 

the figure). The editing options for 

each of these types of fields are 

quite different.

Editing Headlines, 
Bylines and Trailer Ads

The formatting of these fields is 
fixed – editing is limited to chang-
ing the text itself. This ensures that 
your headlines will retain the right 
“look and feel” (and also frees you 
from the painstaking fine manipu-
lation that goes into making head-
line fonts look period-appropriate).

In Adobe terminology, these 

fields are “Plain Text Only.”

Editing Article Bodies

In contrast, the fields which 
make up the bodies of the articles 
themselves are Adobe “Rich Text 
Fields” which allow you significant 
leeway in changing many aspects 
of text formatting (a little like a cut-
down version of a word processing 
package). Using the in-built format 
editing capabilities of Adobe 
Reader, you can make changes 

to: font, font size, paragraph 
indentation, inter-line spacing and 
inter-paragraph spacing. Tweaking 
these parameters can significantly 
change the look of your article and 
also allow you to stretch or squeeze 
text to fill the space available in the 
template (see below)

Changes to the formatting of 
Rich Text Fields are done in Adobe 
Reader through the Properties 
Bar. The easiest way to make this 
dialogue visible is by hitting Ctrl+E 
(although you can also access it 
through the menu system – in 
the latest version of Adobe Reader 
it may be found under “View > 
Show/Hide > Toolbar Items”). 
Once the Properties Bar has been 
made visible, each time you click 
into a Rich Text Field you should 
see detail about its default font 
displayed in the bar, as shown in 
the figure above (marked by ).

Continued on Page Five
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F itt ing Text 
Into F ields

The form fields in the Mutable Deception 
templates are all fixed size. So what happens if 
you keep typing, and the text goes over the end 
of the field? The figure, right, shows how Adobe 
Reader handles this situation: it puts a scroll 
bar at the side of the field and lets you keep on 
typing. While this lets you put more text into the 
field, it doesn’t mean that the field has changed 
in size – it’s just Adobe Reader’s way of letting 
you see everything that has been typed even if 
it’s going to get chopped off when displayed on 
the page. If you leave a field in this overflowed 
state when you exit it, Adobe Reader takes away 
the scroll bar but leaves a small “+” icon next to 
the field to remind you that it still has too much 
text in it to display. If you print the template 
while a field is overflowed, you will simply see 
the part of the field which was on display when 
you last left that field.

So, how do you avoid all your articles 
overflowing the text fields? Simple: you use the 
Rich Text reformatting capabilities described in 
the “Editing Article Bodies” section to change 
the way the text is spaced. In the example 
shown above, the article body includes 12 
points of spacing between each paragraph – if 
the entire article body was selected (Ctrl+A), 
the Properties Bar made visible (Ctrl+E) and the 
“More” button pressed, the spacing after each 
paragraph could easily be changed from 12pt to 

8pt. This would fit the extra text into the field 
by squeezing paragraphs closer together. An 
alternative solution would be changing the line 
spacing, set by default at 9.7pt, to something 
smaller thereby squeezing each line of text 
closer together while leaving the space between 
paragraphs untouched.

With only a little practice, making these 
small formatting “tweaks” quickly becomes an 
easy technique to avoid text fields overflowing.

While you can make some simple changes 
using the basic Properties Bar, for any serious 
formatting you will want to click the “More” 
button at the right end of the bar. This brings 
up a further dialogue that lets you make finer 
changes to font and paragraph. The figure, left, 
shows the paragraph tab of this “Form Field 
Text Properties” dialogue. 

An important point to note about the chang-
es you make in either the “Properties Bar” or 
the “Form Field Text Properties” dialogue is 
that they only apply to the text that is currently 
highlighted in the field. So, if you want to mix 
several fonts in your article, of have some sec-
tions shown in larger font, or centred, all of 
this can be achieved by selecting the parts you 
want changed and tweaking the formatting.
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M a k i n g  R e a l i s t i c  P r o p s

Multiple Column Articles
Several of the templates included in Mutable Decep-

tions, Volume 1 have their article bodies split over mul-
tiple “columns.” Due to limitations in the PDF format, 
there isn’t currently a good way of linking multiple text 
boxes together to cause the contents to “flow” between 
them. Believe us, we tried several different techniques 
before deciding each was impractical. What this means 
is that these templates currently include several inde-
pendent Rich Text fields representing the body of the 
article (one per column). You will need to cut and paste 
text between them to get the parts of your article to go 
into the columns where you want them.

Columns that overflow will, as with any other text 
box, show up with a “+” icon which indicates they 
will be clipped when printed. You should use a com-
bination of the techniques described above, and simple 

movement of text between columns via Cut (Ctrl+X) 
and Paste (Ctrl+V) to ensure that no text drops off 
your multi-column article.

Saving a Completed 
Template

Fillable Adobe PDF forms come in two types – those 
you can fill out and print but not save, and those which 
also allow you to save upon completion (keeping all data 
entered you have typed into the form). The templates PDFs 
in Mutable Deceptions, Volume 1 are of the latter variety.

This means that once you have finished crafting 
your perfect news articles using the templates, you can 
select “File > Save As” to save a copy of the PDF 
form with your data stored in it.

The templates included in 
Mutable Deceptions, Volume 1 give 
you a huge head-start in creating 
newspaper clippings which look 
authentic to 1920s and 1930s 
America. Below are a couple of 
other tips and tricks which may 
help you in using the templates 
to craft props which will impress 
your players:

۞	 Low-grade PaPer: Mod-
ern printer paper tends to be of a 
much higher grade and consider-
ably thicker than that used to print 
newspapers (particularly back in 
the Jazz Age). You can drastically 
increase the “tactile realism” of a 
vintage newspaper prop by obtain-
ing lower-grade, lighter-weight 
paper. Props printed on such pa-
per feel more like newspaper to the 
touch and also allow parts of the 
reverse page to “show through” in 
a similar manner to print on real 
newspapers. Some paper suppli-
ers and art stores sell “Newsprint” 
paper which is perfect; if you can-
not find this, a trip down to the 
local office supplies store is likely 
to give you numerous options for 
purchasing paper which is lighter 
and pulpier than usual. Sometimes 
things like “Kid’s Sketch Pads” are 
a convenient way to buy low-quali-

ty paper already pre-cut into a size 
suitable for your printer.  one word 
oF warning: putting lightweight pa-
per through your printer may re-
quire additional care to avoid pa-
per jams – thin paper is also much 
harder to remove from your print-
er if it does get jammed. So exercise 
caution until you are certain your 
printer is comfortable with print-
ing on things like newsprint.

۞ Printing with white BaCk-
ground or textured BaCkground: 
Some people like to print their 
props as black and white ink placed 
directly onto “blank” paper. This is 
a particularly good option if you 
have realistic paper stock to use 
as the basis of the prop (e.g., the 
newsprint paper described above). 
Other people prefer an easier op-
tion of printing a faux paper tex-
ture along with the article, making 
it look like it is printed on aged pa-
per. Mutable Deceptions, Volume 1 
allows you do to either – simply 
use the Black and White version of 
the templates or the Paper Texture 
version as appropriate.

۞	 StyLe oF writing: If you 
read through the sample content 
pre-filled into the templates, you 
will quickly notice that real-world 

journalists from the 1920s and 
1930s wrote in an idiosyncratic 
style which is quite different to the 
way in which modern news is writ-
ten. There is a certain formality in 
the tone of articles, and a preva-
lence of run-on sentences, not to 
mention numerous other little 
quirks. If you are willing to invest 
the time in trying to write your 
own articles in a similar style, you 
will reap rewards when it comes to 
the authenticity of your finished 
props.  Interestingly, it was appar-
ently quite common for newspaper 
articles to list not only the names 
but home addresses of local indi-
viduals mentioned in stories – so 
it would actually be quite peri-
od-authentic to write something 
like “the victim was Mr. Jonathan 
Smith, of 1612 Third avenue in 
Southside”.

۞ Formatting artiCLeS: In 
real-world newspapers of the Jazz 
Age era, the body text was almost 
always fully justified (i.e., “Align 
Justified” using the terminology 
from the Adobe Reader’s Properties 
Bar). The only exception to this was 
in-article section headings (really 
mini-headlines): these were always 
typeset as centred in the column.
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Real-world Jazz Age 
news articles – particularly 
those from the early-to-mid 
1920s – tend to be pretty 
sparse when it comes to il-
lustrating their content with 
photographs. For purposes of 
creating compelling props, 
however, sooner or later you 
are going to want to use the 
templates from Mutable De-
ceptions, Volume 1 to create 
an article incorporating one 
or more photographs. There 
are two basic approaches to 
this task – the “low-tech” 
approach, and the “digital 
trickery” approach.

The Low Tech Approach

Probably the easiest way 
of getting a photograph 
into a printed prop is to 
use good old-fashioned 
(physical) cut and paste. 
This involves creating the 
text of your article using one 
of the Mutable Deceptions 
templates and leaving a 
sufficiently large blank space 
into which your photograph 
will fit. Then simply, print 
out the template, print out 
the photo, cut both out 
and glue or tape the photo 
into the article. If you are 

planning on photocopying 
the prop anyway, you can 
easily create a seamless 
composite in this way.

Don’t worry if you 
paste the photograph in 
slightly skewed, or if there 
are visible lines around the 
edges of the picture – if 
anything, both of these will 
add to the realism rather 
than detract.

Digital Trickery
Alternatively, if you 

want to do your cutting-
and-pasting in the digital 
realm before you commit 
anything to paper, Acrobat 
Reader versions X and XI 
include some features that 
can be coerced into doing 
something along these 
lines. 

Be warned, however, 
that doing this is definitely 
venturing into the more 
advanced end of Adobe 
Reader usage, so you 
may encounter some of 
the quirkier features of 
the software that are less 
intuitive. But if you’re keen 
to give it a go, here’s a 
step-by-step guide to pasting 
custom graphics into a PDF 
(technically as a comment, 
using the “Stamp” tool).

Step One
The first task is to cre-

ate the text of your arti-
cle in one of the Mutable 
Deceptions templates with 
a blank space where you 
would like the photo to be 
pasted. 

The figure above shows 
a simple example.

Step Two

Next, locate the image 
you would like to paste 

into the arti-
cle. You can 
either bring-
your-own im-
age (although 
you will need 
to somehow 
get it cop-
ied into the 
clipboard us-
ing software 
of your own 
choosing), or 
you can use 
one of the 
pictures in-
cluded with 
this product.

To illus-
trate the latter 

case, the figure below shows 
one of the bonus photo 
pages from the end of the 
Mutable Deceptions, Volume 1 
templates PDF. The caption 
on the baseball player pho-
tograph has been customised 
to something suitable for the 
article we are writing. 

The next task is to get a 
bitmap copy of this picture 
into the clipboard. Before 
starting, it’s a good idea to 
turn off spell-checking (unless 
you want red-squiggly lines 
in your article under words 
not in Adobe Reader’s 
dictionary): you can do 
this by unchecking “Check 
Spelling while typing” 
on the dialogue accessed 
via “Edit > Preferences > 
Spelling.” If Adobe Reader 
is still showing the text field 
highlighted in blue, you 
will also want to turn that 
off before we capture the 
picture – this can be toggled 
by clicking the “Highlight 
Existing Fields” button in 
the coloured bar immediately 
above the template page 
(highlighted in the figure left).

Continued on Page eight

Adding Photographs to Articles
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Once you have everything 
ready to go, select “Edit > Take 
a Snapshot” – the cursor will 
change to something resembling 
a cross-hairs. You can click and 
drag to mark out a rectangular 
region to copy – as you go, 
you’ll see the current region 
highlighted in blue. When you 
release the mouse button a 
dialogue should pop up telling 
you the selected area has been 
copied into the clipboard.

Step THREE

Once your carefully-constructed 
photograph is copied into the 
clipboard, the next task is to paste 
it into the article template. Go back 
to the PDF page for the article you 
prepared in Step One. 

The image will be pasted in 
technically as a custom comment 
annotating the PDF form … so we 
will need to open up the “Com-
ments Panel” in Adobe Reader. You 
can do this in one of two ways: 

the easiest is just to 
click on the “Com-
ment” button to the 
upper right, just above 
the “Highlight Existing 
Fields” button. Another 
way is to select “View 
> Comment > Annota-
tions” using the pull-
down menus. Either 
method should open 
up a panel at the right 
hand edge of the Ado-
be Reader window, at 
the top of which is 
a selection of “An-
notation tools”, each 
shown as an icon.

Click on the tool 
that looks like a 
Rubber Stamp. This 
should open a pull-
down menu as shown 

in the figure below. We want to select 
the very bottom option – “Paste 
Clipboard Image as Stamp Tool.”

Once you have selected the 
“Paste Clipboard Image as Stamp 
Tool” menu item, the cursor should 
change into something resembling a 
rubber stamp. Move it around the 
screen until its somewhere close 
to where you want the photograph 
to go and click the mouse. This 
will cause whatever image is in the 
clipboard to be “stamped” into the 
PDF as a comment. 

Chances are that the picture won’t 
be in exactly the right place or be 
exactly the right size. That’s ok, you 
can scale it by selecting the corners 
and dragging. Similarly, you can move 
the image by clicking anywhere in the 
middle and dragging it around.

Once you have sized and placed 
your stamped photograph, it should 
look something like the figure left You 
are now ready to save or print the 
form with the photograph embedded.

troubleshooting lo-res 
snaPshot images: If the images you 
clip out using the Snapshot tool 
always look blocky, take a look at 
“Edit > Preferences > General” and 
see whether Acrobat Reader is set to 
capture snapshots at a particular (low) 
resolution. The option is “Used fixed 
resolution for snapshot tool images” 
and is generally better left unchecked.
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ONE VERY IMPORTANT LIMITATION OF STAMPS IN PDF FORMS.

For whatever reason, Adobe Reader pla
ces stamps into a layer which sits behind the fields of the form. 

This means that clicking on part of a sta
mp which overlaps a text field will usua

lly NOT select the stamp, but 

instead send that click to the text field. 
In particular, this can make it frustrating

 to pick up the corners of a 

stamped image which overlap a field. A
nd if you ever resize your stamp such t

hat it entirely overlaps a form 

field (i.e., it is completely inside a colum
n of the article), you won’t be able to s

elect it at all anymore. This 

is a feature of Adobe Reader, and there’
s nothing much we can do about it. We recommend you always keep 

stamped photos just a little bit wider than
 the columns into which you paste them 

and making sure that at least 

one edge is always outside the text colum
n.

If you want to attempt more advanced 
projects using the templates provided 
in Mutable Deceptions, Volume 1 it 
may be helpful to have some technical 
information about the fonts which were 
used to make the templates and data 
about sizing and spacing of text.

All fonts used in the editable parts 

of the templates have been released by 
their creators as public domain or free 
fonts, usable for any purpose (commercial 
or otherwise) without paid license. 
Quick searches on www.fontspace.com 
and www.dafont.com may locate free 
downloadable versions of these fonts. For 
the two fonts used for the article bodies, 
slightly modified versions of the relevant 

free fonts were created (Cardiff Fuzzed 
and Queen’s Park Fuzzed) – these 
modified versions can be downloaded 
from the page on the Cthulhu Reborn 
blog which describes this product.

Two different “Jazz Age” layout for-
mats were created for Mutable Deceptions, 
Volume 1, each with their own “look & feel.”

T e c h n i c a l  T y p e s e t t i n g  I n f o

“Jazz Age Newspaper 1” 
format

main headLine: Roger White’s “Orgreave Bold” set at 24pt; 
stretched to 80% horizontal and 110% vertical; leading is 25pt; 
tracking is -25.

ABCDEFGHIJKLMNOPQRSTUVWXYZ 
abcdefghijklmnopqrstuvwxyz0123456789

SuB-headLineS: “Wagner Zip-Change Condensed” by 
AbdulMakesFonts, set at 17pt; stretched to 90% horizontal; 
leading is 22pt; tracking is -25.

ABCDEFGHIJKLMNOPQRSTUVWXYZ 
abcdefghijklmnopqrstuvwxyz0123456789

ByLine: Roger White’s “Queens Park Italic” set at 10pt; leading 
is 11pt; tracking is +50.

ABCDEFGHIJKLMNOPQRSTUVWXYZ 
abcdefghijklmnopqrstuvwxyz0123456789

artiCLe Body: “Fuzzed” version of Roger White’s “Queens 
Park” set at 8pt; leading is 9pt; tracking is +50. The first line of each 
paragraph is indented by 10pt and paragraphs are separated by 2pt.

“Jazz Age Newspaper 2” 
format

main headLine: “Franchise Bold” by Weathersbee Type, set at 
36pt; leading is 37pt; tracking is between 0 and +100 depending 
on template.

ABCDEFGHIJKLMNOPQRSTUVWXYZ 
abcdefghijklmnopqrstuvwxyz

SuB-headLineS: “HFF Iconic Ionic” by Have Fun With Fonts, 
set at 24pt and stretched horizontally by 110%; leading is 21pt; 

tracking is +100. 

ABCDEFGHIJKLMNOPQRSTUVWXYZ 
abcdefghijklmnopqrstuvwxyz0123456789

ByLine: There isn’t a byline for this format in any of the 
templates – if there were it would probably be an italic version of 
Roger White’s “Cardiff” set at 10pt or 11pt.

ABCDEFGHIJKLMNOPQRSTUVWXYZ 
abcdefghijklmnopqrstuvwxyz0123456789

artiCLe Body: “Fuzzed” version of Roger White’s “Cardiff” set at 
9pt; leading is 10.5pt; tracking is +25. The first line of each paragraph 
is indented by 14pt; no space is inserted between paragraphs.



Designer Character Sheets for Call of Cthulhu
Your players spend more time during play staring at their Character Sheets than anything else — even the Cheetos box. So, why 
not give them something attractive and functional to look at? Even better, if you like involving gadgets, computers and general 
technology into your game, why not give your players editable PDF versions of their character sheets?

Cthulhu Reborn currently hosts four different custom-designed character sheets for Call of Cthulhu, each designed for a different 
era of play and decorated in a style evocative of that era, whether it be the Art Nouveau of the 1890s, the Art Deco of the 1920s, the 
classical Romanesque look particular to Cthulhu Invictus, or the retro-futuristic look reminiscent of the 1950s “Atomic Age”.

Visit cthulhureborn.wordpress.com for downloads, pics and other goodness
Gaslight 1920s MRP Cthulhu Invictus Atomic Age
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DEADWAVE
Mark Morrison’s

Porphyry
F

Asphodel

Penelope L ove's Geoff Gillan's

A classic Quest through the land of Dreams, 
written by one of the most passionate and 
accomplished writers of Call of Cthulhu’s early 
years, Penelope Love. Dare to revisit the 
Enchanted Forest and the impenetrable city of 
Thran in a desperate journey to save the soul of 
an Arkham girl cursed to unending slumber.   

Somebody is back from the grave. Some-
body bad. Somebody the Investigator 
killed with good reason. Somebody who 
should have stayed dead. Somebody who 
didn’t. Deadwave is a classic Call of Cthulhu 
scenario of zombie-fuelled revenge, written 
by one of the game’s favourite authors.

The 1990s ... a decade of anticipation for 
Witch-haunted Arkham. The disappearance 
of a noted occult author shatters the quiet 
of the sleepy college town; a disappearance 
made all the more shocking by a bizarre trail 
which has culminated in the writer’s latest 
book literally being erased from existance.
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